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TTM1C01: Business Statistics and Information Technology I  

Lecture Hours Per Week: 6 Credits: 4  

Aim: To enable the students to acquire knowledge of mathematics and statistics. Objective: 

At the end of this course, the students should have understood:  

➢ Set operations, matrix and Mathematics of finance  

➢ Statistical tools and their applications  

➢ To introduce the student to Information Technology  

Pedagogy: A combination of Lecture, Case Analysis, Group Discussion, Seminars, Assignments,  

Practical’s and assigned readings.  

  

Module I  

Sets and set operation Venn Diagrams Elements of Coordinate system. Matrices, Fundamental 

ideas about matrices and their operational rules – Matrix multiplication Inversion of square 

matrices of not more than 3rd order solving system of simultaneous liner equations.  

  

Module II  

Theory of equations: meaning, types of equations –simple linear and simultaneous equations 

(Only two variables) eliminations and substitution method only. Quadratic equation factorization 

and formula method (ax2 + bx + c = 0 form only) problems on business application.  

  

Module III  

Progressions: Arithmetic progressions finding the ‘n’th term of an AP and also sum to ‘n’ terms 

of an AP. Insertion of Arithmetic means in given terms of AP and representation of AP. 

Geometric progression: finding nth term of GP. Insertion of GMs in given GP and also 

representation of GP Mathematics of Finance simple and compound interest. (Simple problems 

only). (Theory and problems may be in the ratio of 20% and 80%respectively)  

  

Module IV  

Introduction.: Introduction to Computer: Components, Organization, Operating System,  

Functions of OS, Types of OS, Intellectual Property Rights, Copyrights, Patents, 

Trademarks, Royalty, Geographical Indicators, World wide web, Digital library, Crypto-

currency, Cyber Security-Issues, trends, solutions and strategies.  

  

Module V  

Microsoft Office- Word processing- creating, formatting and printing documents in MS Word, 

Mail merge. MS Excel for spread sheet applications- creating, formatting and printing 

worksheets- functions in Excel- financial functions- PMT, NPV, IRR, IPMT, ISPMT- statistical  

functions- AVERAGE, MEDIAN, AVEDEV, CORREL, INTERCEPT, MAX, MIN- logical  

  functions- Microsoft PowerPoint- creating presentations in PowerPoint- applying templates- 

animation.  

Activity:  
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Develop an Amortization Table for Loan Amount – EMI Calculation. Prepare an Overhead 

Machine / Laboure hour rate through matrices. Prepare a Bank Statement using Simple interest 

and Compound interest. Prepare a Case study.  
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MODULE 1                    

MATRICES  

   

TYPES OF MATRICES   

   

• Row Matrix:   

A matrix is said to be a row matrix if it has only one row.   

• Column Matrix:   

A matrix is said to be a column matrix if it has only one column.   

   

• Rectangular Matrix:   

A matrix is said to be rectangular if the number of rows is not equal to the number of columns.   

   

• Square Matrix:   

A matrix is said to be square if the number of rows is equal to the number of columns.   

   

• Diagonal Matrix:   

A square matrix is said to be diagonal if at least one element of principal diagonal is non-zero and all 

the other elements are zero.   

   

• Scalar Matrix:   

A diagonal matrix is said to be scalar if all of its diagonal elements are the same.   

   

   

• Identity or Unit Matrix: A diagonal matrix is said to be identity if all of its diagonal elements 

are equal to one, denoted by II.    

   

• Triangular Matrix:   

A square matrix is said to be triangular if all of its elements above the principal diagonal are zero 

(lower triangular matrix) or all of its elements below the principal diagonal are zero (upper 

triangular matrix).   

   

• Null or Zero Matrix:   

A matrix is said to be a null or zero matrix if all of its elements are equal to zero. It is denoted by OO.   

   

• Transpose of a Matrix:   

Suppose AA is a given matrix, then the matrix obtained by interchanging its rows into columns is 

called the transpose of AA.   



Business Statistics and Information Technology-I  

 

  

   

  

  
Prepared By: Rahsina.P   
Assistant Professor, Dept. of Travel and Tourism  

     5  

  

 

MATRIX OPERATION   
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Definition of Adjoint of a Matrix   

   

The adjoint of a square matrix A = [aij]n x n is defined as the transpose of the matrix [Aij]n x n, 

where Aij is the cofactor of the element aij. Adjoing of the matrix A is denoted by adj A.   

  

Find the adjoint of the matrix:       

Solution:       We will first evaluate the cofactor of every element,       
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Solution:   
   
   
   

Let  

A=   

 Order of A is 2 × 2   ρ(A)≤ 2   

Consider the second order minor   

   

There is a minor of order 2, which is not zero. ρ (A) = 2   

Cramer's Rule   

   

Cramer's Rule is an explicit formula for the solution of a system of linear equations with 

as many equations as unknowns,   
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SET THOERY 
SET 

It is well defined collection or a class of distinct objects. The objects of the set are called elements 

or members of the set. 

METHODS OF DESCRIBING A SET 

a) Tabular/Roaster/Enumeration Method 

b) Rule/Selector/ Property Builder Method 

 

 TYPES OF SET 

• Finite and infinite set 

• Equality of sets 

• Equivalent sets 

• Null set 

• Singleton set 

• Subset of a set 

• Super set 

• Proper subset 

• Power set 

• Universal set 

• Disjoint sets 

 

SET OPERATIONS 

➢ Union of two sets A  ∪ 𝐵 

➢ Intersection of two sets A∩ 𝐵 

➢ Difference of two sets A-B 

➢ Complement of a set U-A 

 

IMPORTANT LAWS OF SET OPERATION 

➢ Commutative law 

a) A∪ 𝐵 = 𝐵 ∪ 𝐴 

b) A∩ 𝐵 = 𝐵 ∩ 𝐴 
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➢ Associative law 

a) A∪ (𝐵 ∪ 𝐶) = (𝐴 ∪ 𝐵)𝑈𝐶 

b) A∩ (𝐵 ∩ 𝐶) = (𝐴 ∩ 𝐵) ∩ 𝐶 

➢ Distributive law 

a) A∪ (𝐵 ∩ 𝐶) = (𝐴 ∪ 𝐵) (𝐴 ∪ 𝐶) 

b) A∩ (𝐵 ∪ 𝐶) = (𝐴 ∩ 𝐵) ∪ (𝐴 ∩ 𝐶) 

➢ De Morgan’s law 

a) (A∪ 𝐵)′ = 𝐴′ ∩ 𝐵′ 

b) (A∩ 𝐵)′ = 𝐴′ ∪ 𝐵′ 

 

VENN DIAGRAMS 

These are used for representing the set-in pictorial way. Consist of a rectangle and circles. Rectangle 

represent the universal set and circle represents any set. 

 

THEOREMS ON NUMBER OF ELEMENTS IN A SET 

1) n (A∪ 𝐵) = 𝑛 (𝐴) + 𝑛(𝐵) − 𝑛 (𝐴 ∩ 𝐵) 

2) n (A∪ 𝐵 ∪ 𝐶) = 𝑛 (𝐴) + 𝑛 (𝐵) + 𝑛 (𝐶) − 𝑛 (𝐴 ∩ 𝐵) − 𝑛 (𝐴 ∩ 𝐶) − 𝑛 (𝐵 ∩ 𝐶) + 𝑛 (𝐴 ∩ 𝐵 ∩

𝐶) 

 

A∪ 𝐵 𝑠𝑡𝑎𝑛𝑑𝑠 𝑓𝑜𝑟 𝑎𝑡 𝑙𝑒𝑎𝑠𝑡 𝑜𝑛 𝑒𝑜𝑓 𝑡ℎ𝑒𝑚 

A∩ 𝐵 𝑆𝑡𝑎𝑛𝑑𝑠 𝑓𝑜𝑟 𝑏𝑜𝑡ℎ 𝐴 𝑎𝑛𝑑 𝐵 

A∪ 𝐵 ∪ 𝐶 𝑠𝑡𝑎𝑛𝑑𝑠 𝑓𝑜𝑟 𝑎𝑡 𝑙𝑒𝑎𝑠𝑡 𝑜𝑛 𝑒𝑜𝑓 𝑡ℎ𝑒𝑚 

A∩ 𝐵 ∩ 𝐶 𝑠𝑡𝑎𝑛𝑑𝑠 𝑓𝑜𝑟 𝑎𝑙𝑙 𝑜𝑓 𝑡ℎ𝑒𝑚  
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MODULE 2   

EQUATIONS  

   

 Types of Equations:   

   

• Quadratic Equation   

• Linear Equation   

• Radical Equation   

• Exponential Equation   

• Rational Equation  Linear Equations   

• Each term involved in the linear equation is either a constant or single variable or a 

product of a constant. The general form of linear equations with two variables is given 

by  Y = mx + c ,m≠0   

Quadratic Equations   

• The quadratic equation is a second-order equation in which any one of the variable 

contains an exponent of 2. The general form of the quadratic equation is   

• ax2+bx+c = 0, a≠0   

   

Radical Equations   

• In a radical equation, a variable is lying inside a square root symbol or you can say that 

the maximum exponent on a variable is ½   

• Example : a−−√+10=26   

   

Exponential Equations   

• In these math equations, it contains the variables in place of exponents. By using the 

property, an exponential equation can be solved. ax=ay⇒x=y   

   

Rational Equations   

• A rational math equations involves the rational expressions   

• Example : y2=y+24   

   

Simple linear equations in one unknown   

x - 5 = 2 x - 5 + 5 = 2 + 5 x = 7   
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Simultaneous equations of first degree in two unknowns   

    

Solve for ‘x’ and ‘y’   

   

2x + y = 9 .................................(i)   

x + 2y = 21 ................................. (ii)     

Solution:   

   

Using method of substitution:   

   

From equation (i) we get, y = 9   

- 2x   

Substituting value of ‘y’ from equation (i) in equation (ii):   

x + 2(9 – 2x) = 21   

⟹ x + 18 – 4x = 21   

   

⟹ -3x = 21 – 18   

   

⟹ -3x = 3   

   

⟹  -x = 1   

   

⟹  x = -1   

   

Substituting x = -1 in equation 2:   

   

y = 9 – 2(-1)   

   

= 9 + 2   

   

= 11.   

   

Hence x = -1 and y = 11.   

   

This method is known as method of substitution.   
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Quadratic equations   

   

Solve for x: x2-3x-10 = 0   

Solution:   

Let us express -3x as a sum of -5x and +2X.   

→ x2-5x+2X-10 = 0   

→ x(x-5)+2(x-5) = 0   

→ (x-5)(x+2) = 0   

   

 → x-5 = 0   or   x+2 = 0   

 → x = 5   or   x = -2   

   

Simultaneous equations of two unknown when one of them is quadratic and other is linear   

   

   

Solve the following simultaneous equations:   

   

  
   

Solution:   
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Simultaneous equations containing three unknowns   
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MODULE 3   

PROGRESSION   

ARITHMETIC PROGRESSION    

An arithmetic progression is a sequence of numbers such that the difference of any two successive 

members is a constant   

The nth term of an AP   

   

Tn=a+(n−1)d   

   

Example   

   
   

Sum of n terms of an AP.   

  

Sn=n/2[2a+(n−1)d]   
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Here r = 3 Sum of n terms of a GP   

   

  
   

GEOMETRIC MEAN   

   

the geometric mean is a mean or average, which indicates the central tendency or typical value 

of a set of numbers by using the product of their values   

HARMONIC PROGRESSION   

   

a harmonic progression is a progression formed by taking the reciprocals of an arithmetic 

progression   

   

nth term of an H.P   

   

(H.P) = 1/ [a+(n-1)d]   
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example   

   

Determine the 4th and 8th term of the harmonic progression 6, 4, 3,… Solution:   

Given:   

H.P = 6, 4, 3   

Now, let us take the arithmetic progression from the given 

H.P A.P = , ¼, ⅓, ….   

   

Here, T2  -T1 = T3  -T2 = 1/12 = d   

So, in order to find the 4th term of an A. P, use the formula,   

The nth term of an A.P = a+(n-1)d   

Here, a = , d= 1/12   

Now, we have to find the 4th term,   

So, take n=4   

Now put the values in the formula, we have   

4th term of an A.P = ( ) +(4-1)(1/12)   

= ( )+(3/12)   

= ( )+ (¼)   

= 5/12   

Similarly, for 8th term of an A.P,   

8th term of an A.P = ( ) +(8-1)(1/12)   

= ( )+(7/12)   

= 9/12   

Since H.P is the reciprocal of an A.P, we can write the values as:   

   

4th term of an H.P = 1/4th term of an A.P = 12/5   

.   

8th term of an H.P = 1/8th term of an A.P = 12/9 = 4/3   
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SIMPLE INTEREST    

When the interest is calculated on principal at a uniform rate every period, it is called 

simple interest   

   

Simple interest = pnr/100 p- 

Principal amount   

n- Number of years   

   

r- Rate of interest per annum   

   

Example: Calculate the Simple Interest if the principal amount is Rs. 2000, the time period is 1 

year and the rate is 10%. Also, calculate the total amount at the end of 1 year.   

Solution:   

According to the formula of simple interest we have, 

S.I. = [(Principal (P) × Time (T) × Rate (r))  

/ 100] So, from the above values, S.I. = [(2000 × 1 × 

10)] / 100   

= 20000/100   

=200   

So, the simple interest at the end of 1 year will be Rs. 200.  

For the amount after 1 year, A = P + S.I.   

So, A = 2000+200 = 2200   

Hence, the total amount at the end of the given tenure (i.e. 1 year) will be Rs. 2200.   

   

COMPOUND INTEREST    

   

Compound interest is the addition of interest to the principal sum of a loan or deposit A=  

P(1+r/100)n   

Example: A sum of Rs.10000 is borrowed by Akshit for 2 years at an interest of 10% 

compounded annually. Calculate the compound interest and amount he has to pay at the end of 2 

years.   

Solution:   
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Given,   

Principal/ Sum = Rs. 10000,   

Rate = 10%, and   

Time = 2 years   

Amount (A2) = P (1+R100)2   

A2= =10000(1+10100)2   

10000(1110)(1110)=Rs.12100   

Compound Interest (for 2nd year) = A2–P = 12100 – 10000 = Rs. 2100   

   

CONTINUOUS COMPOUNDING   

   

A=P (1+i) n   

Where i= r/100   

Example: An amount of Rs. 2340.00 is deposited in a bank paying an annual interest rate of 3.1%, 

compounded continuously. Find the balance after 3 years.   

Solution:   

Use the continuous compound interest 

formula, Given P = 2340 r = (3.1 / 100) =  

0.031 t = 3   

Use the continuous compound interest formula, A   

= Pert   

Given,   

P = 2340 r = 3.1 = (3.1 /  

100) = 0.031 t = 3   

Here: e stands for the Napier’s number, which are approximately 2.7183.   

However, one does not have to plug this value in the formula, as the calculator has a built-in key 

for e. Therefore,   

A = 2340 e0.031 (3) ≈ 2568.06   

So, the balance after 3 years is approximately Rs. 2,568.06.   
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MODULE 4  

INTRODUCTION TO COMPUTER  

   

   

COMPUTER    

   

A computer is a machine that can be instructed to carry out sequences of arithmetic or logical 

operations automatically via computer programming. Modern computers have the ability to 

follow generalized sets of operations, called programs. These programs enable computers to 

perform an extremely wide range of tasks.   

   

   
  

Components of Computer   

• A motherboard   

• A Central Processing Unit (CPU)   

• A Graphics Processing Unit (GPU), also known as a video card   

• Random Access Memory (RAM), also known as volatile memory   

• Storage: Solid State Drive (SSD) or Hard Disk Drive (HDD   

Input Devices  

1. Keyboard  

2. Mouse  

3. Audio or voice input  

4. Touch screen  

5. Touch pad  

6. Scanners  

7. Graphics tablet  

8. Digital camera  
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9. webcams   

Output Devices   

   

1. Monitor   

2. Printers   

3. Speakers   

4. Head phones   

5. Projectors   

   

Storage Devices   

   

1. Hard disk   

2. Ram    

3. Rom    

4. CD/DVD   

5. Floppy disk   

6. Memory card  7. Pen drive   

   

Peripheral Devices   

   

1. Mouse   

2. Keyboard   

3. Monitor   

4. Printer   

5. Scanner   

   

Communication Devices   

   

1. Bluetooth devices   

2. Infrared devices   

3. Modem   

4. Wi-Fi devices   

  

Hardware of a Pc  

1. Computer case  

2. CPU  

3. Motherboard  

4. Main memory  

5. Hard disk  

6. Video card  
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7. Visual display unit 8. Card reader Limitations of Computer  

1. Lack of commonsense  

2. Inability to contract  

3. Dependence on human assistance  

  

Use Of Computer  

1. Education  

2. Science  

3. Communications  

4. Business 5. Government  

6.   

   

BASIC STRUCTURE OF COMPUTER   

  

   
OPERATING SYSTEM  

• It is the system software responsible for the direct control and management of the hardware 

that makes up a computer and basic system operations.  

• It is a collection of programs that control the overall operation of a computer.  

• It controls the operations of central processing unit, controls the input-output units, storage 

units and provides various support services to execute application programs.  

Functions of Operating System   

1. Instruction   

2. Job management   

3. Resource management  

4. Data management  

5. Input/output Management   

6. Memory Management   
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7. File Management   

8. Processor Management   

9. Job Priority   

10. Special Control Program   

11. Scheduling of resources and jobs   

12. Security   

13. Monitoring activities   

14. Job accounting   

15. managing hardware and software  

16. program execution  

17. interrupts  

18. memory management  

19. accessing data  

20. networking  

21. security  

  

Types of Operating System   

• Batch Operating System   

• Real –tie operating system  

• Multi-user and single user operating systems  

• Multi-tasking and single tasking operating systems.   

• Distributed OS   

• Network OS  •  Embedded systems.  

• Mobile OS   

INTELLECTUAL PROPERTY RIGHTS (IPR)   

   

Intellectual property rights are the rights given to persons over the creations of their minds. They 
usually give the creator an exclusive right over the use of his/her creation for a certain period of 
time.   

• It can be characterized as the property in ideas or their expression  

• It protects the rights of individual and businesses who have transformed their ideas into 

property by granting rights to the owners of those properties.  

   

Types of IPR  

   

1. Copy right   

It is the exclusive right granted by statute to the author of the works to reproduce dramatic, 

artistic, literacy or musical work or to authorize its reproduction by others.  



Business Statistics and Information Technology-I  

 

  

  

  

  
Prepared By: Rahsina.P   
Assistant Professor, Dept. of Travel and Tourism  

     26  

  

2. Trade marks   

It means any symbol, logo, or name used to enable the public to identify the supplier of 

goods. It can be registered, which gives the holder the exclusive right to use them.  

3. Geographical indicators   

It is a name or sign used on certain products or which corresponds to a specific geographical 

location or origin  

4. Industrial design   

It is a process of design applied to physical products that are to be manufactured by mass 

production.  

5. Patents   

It is legal monopoly granted for a limited time to the owner of an invention. It giving the 

holder the exclusive right for a number of years to produce the goods or use the process.  

6. Royality  

It is the brand name of projection screen. It is a sum paid to a patentee for the use of a 

patent or to an author or composer for each copy of a book sold or for each public 

performance of a work.  

7. Trade secrets  

It also like patents but they rely on private measures rather than state action, to maintain 

exclusivity.  

  

WORLD WIDE WEB   

   

The World Wide Web, commonly known as the Web, is an information system where documents 

and other web resources are identified by Uniform Resource Locators, which may be interlinked 

by hypertext, and are accessible over the Internet   

• It is the graphical internet service that provides a network a network of interactive 

documents and the software to access them.  

• It is an internet based navigational system based on document called pages that combine 

text, pictures, forms, sounds, animation and hyperlinks.  

• It is a collection of distributed documents referred to as pages located on computers or 

servers all over the world.  

   

WEB BROWSERS  

It is a program that runs on internet connected computer and provides access to web pages. It is a 

piece of software that acts an interface between the used and the WWW.   

1. Internet explorer   

2. Five fox   

3. Opera   

4. Google chrome   

5. Safari   
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WEB BROWSING  

 Internet browsing also called net surfing is the process of accessing different web sites on the 

internet hosted by various companies, organization, educational institutions etc.  

  

WEB SERVERS  

These are a combination of software and hardware that store document and other content. It is a 

program that accepts request for information, prepared according to the Hyper Text Transfer 

Protocol (HTTP).  

  

SEARCH ENGINE    

A search engine is a software system that is designed to carry out web searches, which means to 

search the World Wide Web in a systematic way for particular information specified in a textual 

web search query.   

   

TYPES OF WEBSITES   

   

1. Portal   

2. News   

3. Informational   

4. Business marketing   

5. Blog   

6. Wikipedia   

7. Online social network   

8. Educational   

9. Entertainment   

10. Web application   

11. personal   

  

DIGITAL LIBRARY  

      It is a special library with a focused collection of digital objects that cam include text, visual 

material, audio material, video material, stored as electronic media formats, along with means 

for organizing, storing, and retrieving the files and media contained in the library collection.  

Features/characteristics  

• library that served as a defined community or set of communities  

• a conglomerate of multiple entities  

• library that incorporates learning and access  

• easy to use  

• no limitation of space  

• scope of improvement.  
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• library that provides fast and efficient access, with multiple access modes.  

• A library with a collection which are large and persist over time, well organized and 

managed.  

• More than a library.  

• No time bound  

  

Advantages  

• No physical boundary  

• No language barrier  

• Round the clock availability  

• Multiple access  

• Structured approach  

• Information retrieval  

• Preservation and conservation  

• Space  

• Networking  

• Cost  

• Protection  

• Downloading and printing  

• Faster access  

• Cross reference to other documents  

• Save preparation/ conservation cost. Space and money  

  

CRYPTO CURRENCY  

     It is a collection of binary data which is designed to work as a medium of exchange wherein 

individual coin ownership records are stored in a ledger which is a computerized database using 

strong cryptography to secure transaction records, to control the creation of additional coins, 

and to verify the transfer of coin ownership. Examples; Bitcoin, Litecoin, Ripple, Cardano,  

Monero  

• Cryptocurrency does not exist in physical form and is typically not issued by a central 

authority.  

• They have been praised for their portability, divisibility, inflation resistance and 

transparency.  

• Cryptocurrencies typically use decentralized control as opposed to a Central Bank Digital 

Currency (CBDC).  

• Cryptocurrencies are decentralized networks based on block chain technology- a distributed 

ledger enforced by a disparate network of computers.  

• They are generally not issued by any central authority, rendering them theoretically immune 

to government interference or manipulation.     
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• It is a form of digital asset based on a network that is distributed across a large number of 

computers. This decentralized structure allows them to exist outside the control of 

governments and central authorities  

• Block chain, which are organizational methods for ensuring the integrity of transactional 

data, are an essential component of many cryptocurrencies.  

• Cryptocurrencies face criticism for a number of reasons, including their use for illegal 

activities, exchange   rate volatility, and vulnerabilities of the infrastructure underlying 

them.  

  

CYBERSECURITY  

       Cyber Security protects a computer system against malicious attacks. These attacks may 

target specific computers or the whole network.  

• It is the state of being protected against the criminal or unauthorized use of electronic data, 

or the measures taken to achieve this.  

• It is the protection of computer systems and networks from information disclosure, theft of 

or damage to their hardware, software, or electronic data, as well as from the disruption or 

misdirection of the services they provide.  

• It ensures the confidentiality, integrity, and availability of data.  

• It consists of technologies, processes and controls designed to protect systems, networks, 

programs, devices and data from cyber-attacks. It is further divided into:  

a) Network security  

The act of preventing the computer network from malicious attackers  

b) Application security  

The act of protecting the security of apps by preventing unauthorized access, protecting 

application data, and making applications tamper resistance.  

c) Operational security  

Prevents unauthorized users from making changes to data that they do not have permission 

to.  

  

Cyber security Issues/ types of cyber security threats.  

1. Malware  

     It is a malicious software such as spyware, ransomware, viruses and worms. Malware 

is activated when a user clicks on a malicious link or attachment, which leads to installing 

dangerous software.  

2. Emotet  

It is an advanced, modular banking Trojan that primarily functions as a downloader or 

dropper of other banking Trojans. Emotet continues to be among the costliest and 

destructive malware.  

3. Denial of service  

It is a type of cyber-attack that floods a computer or network so it can’t respond to requests.  
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4. Man in the middle (MITM)  

MITM attack occurs when hackers insert themselves into a two-party transaction. After 

interrupting the traffic, they can filter and steal data. MITM attacks often occur when a visitor 

uses an unsecured public Wi-Fi network. Attackers insert themselves between the visitor and 

the network, and then use malware to install software and use data maliciously.  

5. Phishing  

Phishing attacks use fake communication, such as an email, to trick the receiver into opening 

it and carrying out the instructions inside, such as providing a credit card number.  

6. SQL injection  

A Structured Query Language (SQL) injection is a type of cyber-attack that results from 

inserting malicious code into a server that uses SQL. When infected, the server releases 

information.  

7. Password attacks  

With the right password, a cyber-attacker has access to a wealth of information. Social 

engineering is a type of password attack that is a strategy cyber attackers use that relies 

heavily on human interaction and often involves tricking people into breaking standard 

security practices. Other types of password attacks include accessing a password database 

or outright guessing.  

8. Hardware and software failure-such as power loss or data corruption 9. Viruses  

Computer code that can copy itself and spread from one computer to another, often 

disrupting computer operations.  

10. Spam  

It is flooding the internet with many copies of the same message, in an attempt to force the 

message on people who would not otherwise choose to receive it. Most spam is 

commercial advertising, often for dubious products, get –rich-quick schemes, or quasi 

legal services.  

11. Scams- unsolicited email that seeks to fool people into revealing personal details or buying 

fraudulent goods.  

12. Identify theft  

It is a crime. It refers to all types of crimes in which someone wrongfully obtains and uses 

another person’s personal data in some way that involves fraud or deception, typically for 

economic gain.it mainly done in the following ways:  

a) Stealing- wallets, purses, computers, mobile devices, cheques or credit offers/ 

statements sent in the mail.  

b) Dumpster diving- to find discarded paper files, CDs, floppy drives, etc.  

c) Phishing/spam- fraudulent emails.  

d) Social engineering- gaining your confidence in person, on the phone, online, postal mail, 

or through email to extract personal information.  

e) Shoulder surfing- viewing your log on activities in public spaces.  
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f) Hacking- password guessing, tricking you to download malware, spyware or other 

software to access information on your computer.  

  

  

Cyber Security Trends  

1. New technologies and devices  

2. Increasing Ransomware attacks  

3. Attacks on cloud services  

4. Outdated and inefficient systems  

5. Remote work risks  

6. Continued use of multi-factor authentication  

7. Increased interest in Data privacy  

  

Cyber Security Strategies  

       It is comprised of high-level plans for how an organization will go about securing its assets 

and minimizing cyber risk.  

1. Creating a secure cyber ecosystem  

2. Creating an assurance framework  

3. Encouraging open standards  

4. Strengthening the regulatory framework  

5. Creating mechanism for IT security  

6. Securing e-governance services  

7. Protecting critical information infrastructure  

8. Train employees in security principles.  

9. Protect information, computers and networks from viruses, spyware and other malicious 

code.  

10. Provide firewall security for internet connection  

11. Download and install software updates the operating system and applications as they 

become available.  

12. Make up copes of important business data and information  

13. Control physical access to your computers and network components.  
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MODULE 5  

MICROSOFT OFFICE  

  

         It is a proprietary product of Microsoft Corporation and was first released in 1990. MS Office 

is available in 35 different languages and is supported by Windows, Mac and most Linux variants. 

It mainly consists of Word, Excel, Power Point, Access, OneNote, Outlook and Publisher  

applications.  

MS Office is a suite of applications designed to help with productivity and completing common 

tasks on a computer. We can create and edit documents containing text and images, work with data 

in spreadsheets and databases, and create presentations and posters.  

  

WORD PROCESSING  

 It refers to the act of using a computer to create, edit, save and print documents. In order to perform 

word processing, specialized software (MS Word) is needed. The editing and formatting 

capabilities of the word processor demonstrate the application’s true power.  

  

Features  

• Creating, editing, saving and printing documents  

• Copying, pasting, moving and deleting text within a document  

• Formatting text, such as font type, bolding, underlining or italicizing.  

• Creating and editing tables  

• Inserting elements from other software, such as illustrations or photographs.  

• Correcting spelling and grammar.  

  

MS WORD  

          Developed by Microsoft. It is used to make professional -quality write-ups, editing and 

formatting the existing documents, creating graphical documents that comprise images and more.  

  

Features  

1. Home: Basic elements that include under this option are font size, font style, font color, bullets, 

line spacing, alignments etc.  

2. Insert: It includes graphs, shapes, images, charts, tables, footer, page number, header etc.  

3. Design: Here we get a list of templates or designs in which you want your document to be created 

to improve your document’s appearance.  

4. Page Layout: Get options like columns, lines, margins, orientation, spacing, identification etc.  

5. Reference:  It is the one of the most useful features that can be used by people who are writing 

books or creating a thesis. Under this option, you get options such as bibliography, table of 

contents, caption, citation, footnote, etc.  

6. Review: Under this tab, Options line grammar, Thesaurus. Spell check, language, translation, 

word count, comments etc. are included.  
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Some Basic Operations in MS Word a) mail merger  

            Mail Merge is most often used to print or email form letters to multiple recipients. Using 

Mail Merge, you can easily customize form letters for individual recipients. Mail Merge is also 

used to create envelops or labels in bulk.  

It is a word processing procedure which enables you to combine a document with a data file, for 

example list of names and addresses, so that copies of the document are different for each person it 

is sent to.  

1. in a blank MS Word document, click on the mailings tab, and in the Start Mail Merge 

group, click Start Mail Merge.  

2. click step-by-step Mail Merge Wizard  

3. select your document type  

4. select the starting document  

5. select recipients  

6. write the letter and add custom fields.  

b) Page layout  

Word offers a variety of page layout and formatting options. We can customize the page 

orientation, paper size and page margins depending on our document to appear.  

1. Select the Page Layout tab.  

2. Click the Orientation command in the Page Setup group  

3. Click either Portrait or Landscape to change the page orientation.  

c) Page margins  

These are the blank space around the edges of the page. MS Word offers several page 

margins options. We can use the default page margins or specify our own. Margins are 

different such as Normal, Narrow, Moderate, Wide, Mirrored etc.  

1. Select the page layout tab  

2. Click the margins command, a menu of options appears. Normal is selected by default.  

3. Click the pre -defined margin size you desire.  

  

  

MS EXCEL  

  

            It is a software program produced by Microsoft that allows users to organize, format and 

calculate data with formulas using a spreadsheet system.  

• It is a spreadsheet program. That means it’s used to create grids of text, numbers and formulas 

specifying calculation. That’s extremely valuable for many businesses, which use it to record 

expenditures and income, plan budgets, chart data and succinctly present fiscal results.  

• The main features of MS Excel include inserting a pivot table, sorting of tabulated data, adding 

formulas to the sheet, and calculating large data.  
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Features of Spreadsheet  

• Spreadsheets are much useful in business field  

• It can be used for the purposes such as accounting, sales, inventory control and financial analysis.  

• Spreadsheet are also used for many other non- business problems  

• In addition to routine jobs, spreadsheets are also used for financial analysis and forecasting  

• Long term strategy to be followed by a business concern can easily be determined with the help 

of spreadsheet  

• These are also useful to provide guidance to the investors to select and invest in the most 

profitable securities.  

  

Worksheet  

         The term worksheet used in excel documents is a collection of cells organized in rows and 

columns. It is the working surface you interact with to enter data.  Each worksheet contains 1048576 

rows and 16384 columns and serves as a giant table that allows you to organize information.  

  

Parts of the Excel Window   

a) Workbook: also called a spreadsheet, the workbook is a unique file created by Excel. File 

in MS Excel is called a workbook. It is organized in various worksheets/spreadsheets.   

b) Worksheet: it is a table like document containing rows and columns that contain data and 

formulas. It consists of Columns, Rows and their intersections called Cell.  

c) Cell: The combination of a column coordinate   

d) Title bar: it displays both the name of the application and the name of the spreadsheet.  

e) Menu bar: it displays all of the menus available for use in Excel like file, edit, view, insert 

etc.  

f) Toolbar: some commands in the menus have pictures or icons associated with them. These 

pictures may also appear as shortcuts in the toolbar.  

g) Column headings: each excel spreadsheet contains 256 columns. Each column is named 

by a letter or combination of letters  

h) Row headings: each spreadsheet contains 65536 rows. Each row is named by a number.  

i) Name box: this shows the address of the current selection or active cell.  

j) Formula bar: it displays information entered or being entered as you type in the current or 

active cell. The contents of a cell can also be edited in the formula bar.  

k) Cell: a cell is an intersection of a column and row. Each cell has a unique cell address. The 

heavy border around the selected cell is called the cell pointer.  

l) Navigation buttons and sheet tabs: navigation button allow you to move to another 

worksheet in an excel workbook. They are used to display the first, previous, next, and last 

worksheet in the workbook. Sheet tabs separate a workbook into specific worksheets. A 

workbook defaults to three worksheets. A workbook must contain at least one worksheet.  

m) The Ribbon: ribbon used to issue commands, located near the top of the Excel window, 

below Quick Access Toolbar. Ribbon contains commands organized in three components  
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TABS, GROUPS and COMMANDS  

j)  Ranges: a group of cells is called Range. T also have a range address by specifying its upper-

left cell address and its lower-right cell address, separated by a colon. E.g., A1: E4  

Basic concepts of spreadsheet a) Starting Excel  

1. To use MS Excel, we could click start- programs- MS Excel  

2. Start- new office Document  

b) Backstage view  

it acts as the central place for managing worksheets. It will help in creating new sheet, saving 

and opening sheet, printing and sharing sheets, and so on.  

1. Click the File Tab, located in the upper-left corner of the Excel Ribbon.  

If you already do not have any opened sheet then you will see a window listing down 

all the recently opened sheet.  

If you already have an opened sheet then it will display a window detail about the opened 

sheet. Backstage view shows three columns when you select most of the available 

options in the first column.  

Exit Backstage option view: it is simple to exit from Backstage view. either click on 

File tab or press ESC button on the keyboard to go back in excel working mode. c) Auto fill it 

has the ability to fill out some cells with values that belong to a common series. Excel recognizes 

series of items so far as they can be clearly identified, either by the common language or by 

defining them explicitly in a worksheet. Common series include time, dates, weekdays, or 

months.  

d) Saving a workbook  

1. Click the File tab and select Save As.  

2. Select a folder where you want to save the file. Enter file name and select a Save as type.   

3. Click save. Excel saves your file.  

e) Creating a new worksheet  

1. Right click the Sheet Name and select Insert option  

2. Now you can see the insert dialog with select worksheet option as selected from the 

general tab. Click Ok button  

3. Now you will be having a new blank sheet where typing of text can be started.  

f) Cell formatting: excel cell can hold different types of data like numbers, currency, dates, 

etc,  

Right click on the cell-format cells-number 

Click on the ribbon from the ribbon Types of 

cell formats:  

General  

Number  

Currency  

Accounting  

Date  
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Time  

Percentage  

Fraction  

Scientific  

Text  

Special  

Custom  

g) Merge cells: enables to merge two or more cells. When merge cells, we cannot combine the 

contents of cells.   

1. To merge cells, select the cells want to merge and then click the Merge & Center button   

2. Choose Alignment tab of the Format cells dialogue box to merge cells  

3. The home-alignment group-merge &center control contains a drop -down list with these 

additional – merge across, merge cells, unmerge cells  

h) Formatting cells: right click-format cells-select tab.  

i) Formatting worksheet: choose page layout- sheet options group- gridlines-check print  

j) Filtering: refers to displaying only the rows that meet certain conditions. It hides other rows 

which we do not want to be displayed.  

1. Click the column that contain the data you wish to filter  

2. On the Home tab, click on sort & filter   

3. Click Filter button  

4. Click the Arrow at the bottom of the first cell.  

5. Click the Text Filter  

6. Click the words you wish to filter.   

7. To clear the filter, click the sort & filter button 8. Click clear.  

k) Ranges: a group cell is called a range. Ranges can also have a range address by specifying 

its upper – left cell address and its lower-right cell address, separated by a colon. Eg; A1:E4  

is a range which consists of 20 cell (four rows by five columns) Selecting 

ranges: there are different methods to select ranges.  

1. Press the left mouse button and drag, highlighting the range. Then release the mouse 

button.  

2. Press the shift key you use the navigation keys to select a range.  

3. Press F8 and then move the cell pointer with the navigation keys to highlight the range. 

Press F8 again to return the navigation keys to normal movement.  

4. Type cell or range address into the Name box and press Enter. Excel selects the cell or 

range that you specified.  

m)  Entering Data  

                sheet area is the area where we can type our text. The flashing vertical bar is called 

the insertion point and it represents the location where text will appear when you type. When 

you click on a box then box becomes highlighted. When you double click the box flashing 

vertical bar will come and you can start entering data then.  



Business Statistics and Information Technology-I  

 

  

  

  

  
Prepared By: Rahsina.P   
Assistant Professor, Dept. of Travel and Tourism  

     37  

  

n) Saving a workbook  

      After finishing the work, we want to save the file. To save our file.  

1. Click the File tab and select Save As button.  

2. Select a folder where you want to save the file. Enter the file name and select a Save As 

type. By default, it is .docx format  

3. Click Save. Excel saves your file.  

o) Creating a new worksheet  

When we start Excel there are three new blank sheets always open. Each worksheet has a 

tab. By default, a workbook has three sheets and they are named sequentially, starting with 

sheet1. We can add additional worksheet in the work book.   

1. Right click the Sheet Name and select Insert option.  

2. Now you can see the insert dialog with select Worksheet option as selected from the 

general Tab. Click Ok button.  

3. Now you will be having a new blank sheet where typing of text can be started.  p) 

Deleting worksheet  

To delete a workbook, right-click its tab and click Delete.  

  

EDITING WORKSHEET  

Editing of worksheet involves the following  

a) Inserting Data  

For inserting data in MS Excel just activate the cell type text or number and press enter or 

Navigation key. In each cell, we can insert three kinds of data namely Text, Numeric value 

or Formulas.  

b) Inserting formula  

For inserting formula in MS excel go to formula bar, enter the formula and then press enter 

or navigation key.  

c) Modifying cell content  

Editing cells content consists of deleting, replacing, altering, or adding something in them. 

If we click a cell and start typing, its content will be replaced with the new entry. If we want 

to add or subtract something to a cell’s content, we can double-click it; this puts the cell in 

Edit mode and we can then proceed.  

d) Move data (cut and paste) e) Symbols: go to insert-symbols-special characters to view 

available special characters. f) Delete data  

1. Delete the mouse. Select the data to be deleted. Right click on the sheet. Select the delete 

option, it will delete the data  

2. Delete with delete key  

Select the data you want to delete. Press on the delete button from the keyboard, it will 

delete the data  
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3. Selective delete for rows  

Select the rows which you want delete with Mouse click+ control key. Then right click it 

will show various options. Select the Delete option to delete the selected rows. g) Sorting  

We can sort data by text (A to Z or Z to A), numbers (Smallest to largest or largest to 

smallest), and date and times (oldest to newest or newest to oldest) in one more column.  

1. Highlight the cells that will be sorted  

2. Click the Sort & filter button on the Home tab  

3. Click the sort Ascending button or Descending button  

  

FORMULA IN MS EXCEL  

  

Formulas are mathematical equations. There sis a list of the functions available within Excel under 

the Formula tab. Formulas or functions must begin with an equal sign (=).  

a) Basic Maths Function  

        Spreadsheet have many math functions built into them. Basic maths operations are Add, 

Subtract, Multiply, Exponential and Divide.   

b) AutoSum  

           The home tab contains a very smart button called the AutoSum. There are two most primary 

ways of using the AutoSum. Before performing the SUM function, the computer will ask whether 

it found the right cells that we want to get the sum of. If the computer found the right cells, press 

Enter; otherwise use our mouse or our keyboard to select the cells we want to consider. We can 

also select the cells involved in a sum plus an empty cell that will be used to display the result, and 

then click the AutoSum button.  

Automatic calculation (setting automatic calculation)  

1. Choose formulas tab from the Ribbon  

2. Choose the calculation options tab  

3. Select automatic if it is not already selected  

4. Click Ok  

  

FUNCTIONS  

          Excel has a set of prewritten formulas called functions. Functions differ from regular formulas 

in that we supply the value but not the operators, such as +, -, *, /.   

Eg, =SUM (2, 13, A1, B27)  

a) SUM function  

It is used to add the contents of various cell. The SUM function takes all of the values in 

each of the specified cells and totals their values.   

Syntax:   = SUM (first value, second value, etc)  

b) PRODUCT function  

It calculates the product (multiplication) of a supplied set of numerical values.  

Syntax: PRODUCT (number1, [number 2],….) c) SQRT function  
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It calculates the positive square root of a supplied number  

Syntax: SQRT (number)  

d) ROMAN  

It converts an Arabic number to Roman. i.e., for a supplied number, the function returns a 

text string depicting the roman numerical form of the number  

Syntax: ROMAN (number, [form])  

e) ROUND  

It rounds a supplied number up or down, to a specified number of decimal places.  

Syntax: ROUND (number, num_digits)  

   

STATISCAL FUNCTIONS  

                  Excel provides many other statistical, financial, and engineering worksheet functions. 

Some of the statistical functions are built in and others become available when we install the 

analysis Toolpak. The important among them are the following.  

  

 a)  AVERAGE  

The AVERAGE function displays the average or mean value of selected cells. It takes the sum of 

the cells involved. (We need not to calculate the sum first), divides the result by the number or 

cells involved, and displays the result. Its syntax form is shown below.  

Syntax: AVERAGE (number1, number2…)  

  

Calculating Min:  

 We can use the MIN function to find the lowest number in a series of numbers.  

Calculating Max:  

 We can use the MAX function to find the highest number in a series of numbers.  

Calculating Count:  

 We can use the COUNT function to count the number of items in a series.  

b) MEDIAN  

MEDIAN function calculates the median of the given numbers. The median is the number in the 

middle of a set of numbers. That is, half the numbers have values that are greater than the median, 

and half have values that are lower than the median.  

 Syntax: MEDIAN (number1, number2,…)  

c) AVEDEV  

AVEDEV calculates the average of the absolute deviations of data points from their mean. 

AVEDEV is a measure of the variability in a data set.  

 Syntax: AVEDEV (number1, number2,…)  

d) STDEV  

This statistical function estimates standard deviation based on a sample. The standard deviation is 

a measure of how widely values are dispersed from the average value or the mean.  
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 Syntax: STDEV (number1, number2,…)  

  

 e)  CORREL   

CORREL calculates the correlation coefficient of the array 1 and array 2 cell ranges. Use the 

correlation coefficient to determine the relationship between two properties. For example, we can 

examine the relationship between a location’s average temperature and the use of air conditioners.  

 Syntax: CORREL (array1, array2) f) 

MODE  

The MODE function calculates the statistical mode. Mode is the most frequently occurring value 

of a series of numbers. If there are 2 or more most frequently occurring values in the supplied 

data, the functions show the lowest of these values.  

 Syntax: MODE (number1, [number2],…) g) 

MODE SNGL  

It returns the statistical mode (the most frequently occurring value) of a list of supplied numbers. 

If there are 2 or more most frequently occurring values in the supplied data, the function returns 

the lowest of these values.  

Syntax: MODE.SNGL (number,[number2],…) h) 

 MODE.MULT  

This function returns a vertical array of the statistical modes (the most frequently occurring 

values) within a list of supplied numbers  

Syntax: MODE.MULT(number1, [number2],….) i) 

 FORECAST  

This function predicts a future point on a linear trend line fitted to a supplied set of x-and yvalues. 

It calculates the new y-value from the simple equation for a straight line  

Syntax: FORECAST (x, known_y’s,known_x’s)  

  

FINANCIAL FUNCTIONS  

         These functions have been provided to perform many of the commonly used financial 

calculations, such as calculation of yield, interest rates, investment valuations, internal rate of 

return, payments and asset depreciation  

  

 a)  FV FUNCTION  

It calculates the Future Value of an investment with periodic constant payments and a constant 

interest rate.  

Syntax: FV (rate,nper,[pmt],[pv],[type])  

 b)  PV FUNCTION  

It calculates the present value of an investment. The present value is the total amount that a series 

of future payments is worth now. Syntax: PV (rate, nper, pmt, fv, type)  
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 c)  NPV FUNCTION   

It calculates the net present value of an investment based on a series of periodic cash flows and a 

discount rate. The net present value of an investment is today’s value of a series of future 

payments.  

Syntax: NPV (rate, value1, value2,…) d) IRR  

It calculates the internal rate of return for a series of cash flows represented by the numbers in 

value. It is the interest rate received for an investment consisting of payments and income that 

occurs at regular periods. Syntax: IRR (values, guess)  

e) PMT FUNCTION  

It calculates the periodic payment for a loan based on constant payments and a constant interest 

rate.  

Syntax: PMT (rate, nper, pv, fv, type) f) 

IPMT  

It calculates the interest payments for a given period for an investment based on periodic, 

constant payments and a constant interest rate. Syntax: IPMT (rate, per, nper, pv, fv, type) 

g) NPER  

This function calculates the number of peiods required to pay off a loan, for a specified constant 

periodic payment and a constant interest rate. Syntax: NPER (rate, pmt, pv, [fv], [type])  

h) DB FUNCTION  

it calculates the depreciation of an asset, using the Fixed Declining Balance method for each 

period of the asset’s lifetime  

Syntax: DB (cost, salvage, life, period, [month])  

i) SLN FUNCTION  

It calculates the straight-line depreciation of an asset for one period.  

 Syntax: SLN (cost, salvage, life)  

  

DATABASE FUNCTIONS  

MS Excel includes worksheet functions that analyze data stored in lists or databases. Each of these 

functions, referred to collectively as the Dfunction, use three arguments: database, field and 

criteria.   

  

a) DAVERAGE  

This function averages the values in a column of a list or database that match conditions we 

specify. Function calculates the average of values in a field (column) in a database for 

selected records, that satisfy user-specified criteria.  

Syntax: DAVERAGE (database, field, criteria)  
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b) DCOUNT  

Counts the cells that contain numbers in a column of a list or database that match conditions 

we specify.  

Syntax: DCOUNT (database, [field], criteria) c) DMAX  

It finds the maximum value (largest number) in a field (column) in a database for selected 

records only.  

Syntax: DMAX (database, filed, criteria) d) DMIN  

This calculates the smallest number in a column of a list or database that matches conditions 

we specify.  

Syntax: DMIN (database, field, criteria)    e) DSUM  

This function calculates the sum of a field in a database for selected records, that satisfy 

user-specified criteria.  

Syntax: DSUM (database, field, criteria)  

  

LOGICAL FUNCTIONS  

There are many built-in Excel logical functions. These functions include the Boolean operators 

and conditional tests, which will be an essential part of many working spreadsheets.  

  

a) AND Function  

 The Excel AND function test a number of supplied conditions and returns a result of:  

• TRUE if ALL of the conditions evaluate to TRUE  

• FALSE otherwise (i.e., if ANY of the conditions evaluate to FALSE)  

Syntax: AND (logical_test1,[logical_test2],…) b) The IF Function  

The IF function is useful to test a condition and have one value returned if the condition is 

TRUE, and another value returned if the condition is FALSE.  

Syntax: IF (logical-test, value-if-true, value-if-false) c) OR Function  

It is a basic logical function that is used to compare any two statements or values. The OR 

function returns TRUE if any of the conditions are TRUE and returns FALSE if all 

conditions are false.  

Syntax: OR (logical_test1, [logical_test2],….) d) NOT Function   

The NOT function receives a logical value and simply returns the opposite logical value.  

i.e., if supplied with the value TRUE, the NOT function returns FALSE and if supplied with 

the value FALSE, the function will return the value TRUE.  

Syntax: NOT (logical)  

  

e) TRUE Function  

This function returns the logical value TRUE  

Syntax: TRUE( ) f) FALSE Function  

This function returns the logical value FALSE  
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Syntax: FALSE ( ) g) IF ERROR Function  

This function tests if an initial supplied value (or expression) returns an error. And if so, 

returns a second supplied argument, otherwise the function returns the initial value. Syntax: 

IFERROR (value, value_if_error)  

  

MS POWERPOINT  

         It is presentation program which gives you access to the quickly create, edit, view, present, 

or share presentations quickly and easily.  

The power point window includes the office button, quick access toolbar, title bar, tabs, scroll 

bars and a status bar.   

        Quick access toolbar contains buttons for commonly used commands. Title bar indicates the 

software, the name of the presentation that is open, minimize, maximize, and close buttons.  

  

Advantages of PowerPoint  

• It can be used virtually anywhere  

• It is a collaborative solution  

• Can choose to create own design or use existing ones   

• Multiple uses  

• Export in different formats  

• It facilitates an effective way of communication with the audience  

• Can insert multimedia formats  

• Extremely efficient tool  

• It is accessible for all categories of users  

  

Functions in PowerPoint  a)  Creating a power point presentation  

          power point presentation work like slide shows. To coney a message or a story, you break 

it down into slide. Think of each slide as a blank canvas for the pictures and words that help you 

tell your story.  

When you open power point, you will see some built in themes and templates. A theme is 

a slide design that contains matching colors, fonts, and special effects like shadows, reflections 

and more.  

1. On the file tab of the ribbon, select new and then choose a theme  

Power point shows you preview of the theme, with four color variations to choose from 

on the right side.  

Click create, or pick a color variation and then click create.  

b) Insert a new slide:  On the home tab, click the bottom half of new slide, and pick a slide 

layout.  

c) Save presentation  

1. on the file tab, choose save  

2. pick or browse to a folder  
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3. in the file name box, type a name for your presentation, and then choose save.  

d) Add text: select a text placeholder, and begin typing  

e) Format your text  

1. Select the text  

2. Under drawing tools, choose format  

f) Add pictures: on the insert tab, do one of the following:  

1. To insert a picture that is saved on your local drive or an internal server, choose pictures, 

browse for the picture, and then choose insert.  

2. To insert a picture from the web, choose online pictures, and use the search box to find 

a picture.  

3. Choose a picture, and then click insert.  

g) Applying templates  

1. Click file, and then click new  

2. Do one of the following: type a key word or phrase into the search for online templates 

and themes field, and press Enter. Choose a template  

3. When find the template that you need, click it and click create.  

h) Applying animation  

1. Select the object on the slide that you want to animate.   

2. On the animation tab, click animation pane 3. Click add 

animation, and pick animation effect.  

4. To apply additional animation effects to the same object, select it,   

5. Click add animation and pick another animation effect  

  

  

  

  

  

  

  

  

--------------END-------------  

  

THANK YOU  

  

  


